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Abstract

These Application Notes describe the procedures for configuring Gamma Telecom IP
DirectConnect Session Initiation Protocol (SIP) Trunking with Avaya IP Office Release 10.1
and Avaya Session Border Controller for Enterprise Release 7.2.

Gamma Telecom IP DirectConnect SIP Trunking provides PSTN access via a SIP trunk
between the enterprise and the Gamma Telecom network as an alternative to legacy analog or
digital trunks. This approach generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between service provider Gamma Telecom and Avaya IP Office solution. In the sample
configuration, the Avaya IP Office solution consists of an Avaya IP Office Server Edition release
10.1, Avaya Session Border Controller for Enterprise release 7.2 (Avaya SBCE), Avaya Voicemail
Pro, Avaya Communicator for Windows and Avaya H.323, SIP, digital, and analog endpoints.

The Gamma Telecom IP DirectConnect (Gamma) SIP Trunking service referenced within these
Application Notes is designed for business customers. The service enables local and long distance
PSTN calling via standards-based SIP trunks as an alternative to legacy analog or digital trunks,
without the need for additional TDM enterprise gateways and the associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office to
connect to Gamma IP DirectConnect SIP Trunking service via the Avaya SBCE. This configuration
(shown in Figure 1) was used to exercise the features and functionality tests listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. . The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in these DevConnect
Application Notes included the enablement of supported encryption capabilities in the Avaya
products. Readers should consult the appropriate Avaya product documentation for further
information regarding security and encryption capabilities supported by those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is the
responsibility of each individual vendor. Readers should consult the appropriate vendor-supplied
product documentation for more information regarding those products.

2.1. Interoperability Compliance Testing

A simulated enterprise site with Avaya IP Office was connected to Gamma SIP Trunking service via
the Avaya SBCE. To verify SIP trunking interoperability, the following features and functionality
were exercised during the interoperability compliance test:

e Response to SIP OPTIONS queries.

e Incoming PSTN calls to various phone types. Phone types included H.323, SIP, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.
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e QOutgoing PSTN calls from various phone types. Phone types included H.323, SIP, digital,
and analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

¢ Inbound and outbound long holding time call stability.

e Various call types including: local, long distance, international, outbound toll-free, operator
service and directory assistance.

e Codec G.711MU and G.729.

e Caller number/ID presentation.

e Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

e DTMF transmission using RFC 2833.

e Voicemail navigation for inbound and outbound calls.

e Telephony features such as hold and resume, transfer, and conference.

Fax T.38.

Off-net call forwarding.

Twinning to mobile phones on inbound calls.

Avaya Communicator for Windows.

Avaya Communicator for Web client (WebRTC).

Note: Avaya Communicator for Web client (WebRTC) was tested as part of this solution. The
configuration necessary to support Avaya Communicator for Web client is beyond the scope of these
Application Notes and is not included in these Application Notes. For these configuration details, see
Reference [8].

2.2. Test Results
Gamma SIP Trunking passed compliance testing.

Items supported and not tested included the following:

Operator Call (100 national and 155 international) is supported but was not tested.
Local Directory Assistance Calls (118xxx) are supported but not tested.
Emergency 999 is supported but not tested.

Call redirection using REFER method is not supported by Gamma.

Toll free (0800 and +44800) is supported but not tested.

Interoperability testing of Gamma SIP Trunking was completed with successful results for all test
cases with the exception of the observations/limitations described below.

e OPTIONS - Gamma responded to SIP OPTIONS from Avaya IP Office, but it does not
send out OPTIONS.

e Fax G.711 — The testing was conducting from Canada. For inbound fax G.711 from the
PSTN to Avaya IP Office, it took a few tries to get a successful transmission since it was
international fax, which may have been caused by latency, jitter or noise. The
recommendation is to use fax T.38 as it’s supported by Gamma and was tested successfully.

e Fax T.38 — Inbound T.38 fax from the PSTN to Avaya IP Office failed. This is because
Avaya IP Office responded with 2000K with G.729 codecs even though the G.711A was
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first on the codec priority list. This caused the Gamma system not to send out the re-INVITE
to negotiate fax T.38 with IP Office. The work around is to have IP Office configured to use
only G.711ALAW on the VolP SIP line. By doing this, Gamma would send out the re-
INVITE for T.38 fax negotiation resulting in successful fax T.38 transmission. The
recommendation for fax T.38 between Gamma and IP Office is to have G.711 ALAW listed
as the only codec set in the Selected codec list, as shown in Section 5.4.2.

2.3. Support

For technical support on the Avaya products described in these Application Notes, visit
http://support.avaya.com.

For technical support on Gamma SIP Trunking, contact Gamma at http://www.gamma.co.uk/.
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3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to the Gamma SIP Trunking service via the Avaya SBCE through the public IP network.
For confidentiality and privacy purposes, actual public IP addresses used in this testing have been
masked out and replaced with fictitious IP addresses throughout the document.

Located at the enterprise site is an Avaya IP Office Server Edition Primary with the Avaya IP Office
500 V2 Expansion System which provides connections for 16 digital stations and the extension
PHONE 8 card which provides connections for 8 analog stations to the PSTN as well as 64-channel
VCM (Voice Compression Module) for supporting VolP codecs. The LAN port of Avaya IP Office
is connected to the enterprise LAN while the WAN port is connected to the public IP network via
Avaya SBCE. Endpoints include an Avaya 9600 Series IP Telephone (with H.323 firmware), Avaya
11x0 Series IP Telephone (with SIP firmware), an Avaya 9508 Digital Telephone, an Avaya
Symphony 2000 Analog Telephone and an Avaya Communicator for Windows, a separate Windows
PC runs Avaya IP Office Manager to configure and administer the Avaya IP Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user
phones will also ring and can be answered at the configured mobile phones.

Gamma Telecom

Fax@ » SIP Trunking Services
/ 192.168.61.201

PSTN Phon@

& Internet
s '/
MoblleéPhone SIP/
UDP |
Avaya Session Border
Controller for Enterprise Outside 10.10.98.103
Inside 10.10.97.176
WAN_ ) WAN_ D

Avaya IP Office 500 V2
Expansion System

Avaya IP Office Server
Edition Primary

10.10.97.61|

Digital Phone

£y Phone/Fax

Analog 10.10.98.229
10.10.98.62

Enterprise LAN Enterprise LAN Enterprise LAN )

Avaya 11x0 SIP Avaya 9600-Series Avaya Communicator Avaya Communicator Avaya Voicemail Pro
IP Telephone H.323IP Telephone for Windows for Web (WebRTC) for IP Office
= RS 10.10.98.86
: o
S

Figure 1: Test Configuration for Avaya IP Office with Gamma SIP Trunking Service
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For the purposes of the compliance test, Avaya IP Office users dialed a short code of 8 + N digits to
send digits across the SIP trunk to Gamma. The short code of 8 was stripped off by Avaya IP Office
but the remaining N digits were sent unaltered to Gamma. It was configured to send 12 digits in the
From field. Gamma SIP Trunking would send 12 (in United Kingdom format, i.e., +441229317450)
digits in the Request URI and the To field of an inbound SIP INVITE messages.

4. Equipment and Software Validated
The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment Release
Avaya IP Office Server Edition 10.1.0.1 build 3
Avaya IP Office 500v2 (Expansion) 10.1.0.1 build 3
Avaya IP Office Manager 10.1.0.1 build 3
Avaya Voicemail Pro for IP Office 10.1.0.1 build 3
Avaya Session Border Controller for 7.2.1.0-05-14222
Enterprise (running on Portwell CAD-0208
platform)
Avaya 11x0 IP Telephone (SIP) SIP11x0e04.04.23.00
Avaya 9621G IP Telephone (H.323) 6.6401
Avaya Communicator for Windows 2.1.4.84
Avaya Communicator for Web (WebRTC) 1.0.17.1725
Avaya Digital Telephone (9508) 0.45
Avaya Symphony 2000 Analog Telephone N/A

Gamma SIP Trunking Service Components

Component Release
SBC GenBand 8.3.28.0
TSS-Softswitch Or C3 >14.00.03.29 & G9 -1400.03.1P
Genband C3/G9 Softswitch

Note: The test results documented in this Application Notes apply to standalone IP Office V2
deployments as well as all configurations of IP Office Server Edition.
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5. Configure IP Office

This section describes the Avaya IP Office configuration to support connectivity to Gamma SIP
Trunking service through Avaya SBCE. Avaya IP Office is configured through the Avaya IP Office
Manager PC application. From a PC running the Avaya IP Office Manager application, select Start
- Programs > IP Office > Manager to launch the application. Navigate to File = Open
Configuration, select the proper Avaya IP Office system from the pop-up window, and log in with
the appropriate credentials. A management window will appear similar to the one shown in the next
section. The appearance of the IP Office Manager can also be customized using the View menu. In
some screens presented in this section, the View menu was configured to show the Navigation pane
on the left side, the Group pane in the center, and the Details pane on the right side. Some of these
panes will be referenced in Avaya IP Office configuration. Proper licensing as well as standard
feature configurations that are not directly related to the interface with the service provider (such as
LAN interface to the enterprise site) is assumed to be already in place.

5.1. LAN Settings

In the sample configuration, SEQT VM was used as the system name and the WAN port was used
to connect the Avaya IP Office to the public network. The LAN2 settings correspond to the WAN
port on the Avaya IP Office.

To access the LAN settings, first navigate to System (1) > SEQT VM in the Navigation and then
navigate to the LAN2 - LAN Settings tab in the Details pane.

Set the IP Address field to the IP address assigned to the IP Office WAN port.
Set the IP Mask field to the mask used on the public network.

All other parameters should be set according to customer requirements.

Click OK.

Configuration |7 SEQT VM* Bk -E X v <>

- R BOOTP (8)

£ VolP Security Contact Center
#1147+ Operator (3)

=153 Solution System LAN1 LANZ  DNS Voicemail Telephony Directory Services  System Events  SMTP SMDR  VolP
0@ User(30) LAN Settings VolP  Network Topol
+# Group() g o ork Topeology
+-@ Short Code(43) IP Address 10 10 97 &1
-~ Directory(0)
£ Tirme Profile(D) 1P Mask 253 . 255 . 255 . 240

----- il Account Code(0)
+-§3 User Rights(9)
‘i Location(D)

= SEQT VM

Yy

MNumber Of DHCP IP Addresses 200

=7 System (1) DHCP Mede
%59 SEQT VM
2% Line (2) (O Server (O Client (@ Disabled Advanced

= Control Unit (8)
-4 Extension (6)
4 User (M Help
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Select the Vol P tab as shown in the following screen.
e The SIP Trunks Enable box must be checked to enable the configuration of SIP trunks to

Gamma.

e The Layer 4 Protocol, check the UDP, TCP and TLS boxes. Then set UDP and TCP Ports
to 5060, and TLS port to 5061.

e Enable RTCP Monitoring on Port 5005 and Keepalives should be set as shown in capture

below.
e All other parameters should be set according to customer requirements.
e Click OK.
Configuration = SEQTVM* of - .

=R BOOTP (8)
~i# Operator (3)

#-§  User(30)

=13 Group(1)
+-B% Short Code(45)
- Directory(0)
£ Time Profile(0)

= Control Unit (8)
+® Extension (6)
+ : User (T}
i-ia Group (0)
#% Short Code (30)
@ Service (0]
@ Incoming Call Route (8)
*x Directory (0)
ime Profile ()
IP Route (1)
Ml Account Code (0)
= License (30)
3 User Rights (9]
¥ ARS(1)
5 Location (0)
ﬂ Authorization Code (0)
4555 |PO SP EXP

5

System LANT  LAN2  DNS
olution LAN Settings  VolP

Netwerk Topology

[] H.223 Gatekeeper Enable

[] Auto-create Extension Auto-create User

Voicemail Telephony Directory Services  System Events

SMTP  SMDR VolP

[] H.323 Remote Extension Enable

H.323 Signaling over TLS Disabled \/| 1720 =
SIP Trunks Enable
[[] SIP Registrar Enable
[ Auto-create Extension/User [ sIP Remote Extension Enable
SIP Domain Name |
SIP Registrar FODN |
upp UDP Port |5080 5 =
Layer 4 Protocol TCP TCP Port  |3060 = =
TLs TLS Port |5061 = 061 E
Challenge Expiration Time (sec) 10 s
RTP

Port Number Range

Minimum 40750 B Maximum 50750
Port Number Range (MAT)
Minimurn 40750 s Maximum 30750

Enable RTCP Monitoring on Port 5005

RTCP collector IP address for phones

VolP Security Contact Center

ES

Keepalives
Scope RTP-RTCP ~ | Periodic timeout
Initial keepalives Enabled ~ v
£ >
oK Cancel Help

In the compliance test, the LAN1 interface was used to connect IP Office to the enterprise site IP
network. The LANL1 interface configuration is not directly relevant to the interface with Gamma SIP
Trunking service, and therefore is not described in these Application Notes.
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5.2. System Telephony Settings

Navigate to the Telephony - Telephony Tab in the Details pane.

e Choose the Companding Law typical for the enterprise location. For Europe, ALAW is

used.

e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and call
transfer to the PSTN via the service provider across the SIP trunk.

e Uncheck the Drop External Only Impromptu Conference box to allow the host of the
conference leaving the active call without forcing all the parties off the conference.

e Other parameters are left at default.

e Click OK.
Configuration ‘ P SEQTVM* & v
+‘$ gOOTf (9()3) Systern  LANT  LANZ  DNS Voicemail Telephony  Directory Services  System Events SMTP  SMDR  VolP VolP Security Contact Center
perator
Solution Telephony  Park 8 Page Tones & Music Ring Tones  SM CallLeg TUI

@ User (30)

E - 1 2
+ﬂ Group(1) Dial Delay Time (sec) 4 = Companding Law
+-8% Short Code(45) Switch Line
- Directory(D) Dial Delay Count 0 =
£ Time Profile(0) = _
.4 Account Code(0) Default No Answer Time (sec) 15 = O U-Law U-Law Line
+§' User Blghts(?) Held Timeout (sec) 720 =
IE Location(0) ® AL ® A-Lawl
-5 SEQT VM Park Timeout (sec) 300 2 e Tawne
System (1)
= SEQT VM Ring Delay (sec) 3 =
-1 Line (3) [ DSS Status
+ = Control Unit () Call Priority Promotion Time (sec) Disabled s
+® Extension (6] [ Aute Heold
+§“ gser (?3:[)) Default Currency usp ~ Dial By Name
roup ) >
+s Short Code (51) Default Name Priority Faver Trunk Show Account Code
Service (0) - . . o
Incoming Call Route Media Connection Preservation Enabled [ Inhibit Off-Switch Forward/Transfer
@& Direct 0 i i ~
Tilrr_:: ;szle) ) P;:'Dne Fca”:acck o SIS [ Restrict Metwork Interconnect
Il 1P Route (1) ogin Code Complexty Include location specific information
& Account Code (0] [ Enforcement
% License (30) n = [] Drop External Only Impromptu Conference
§5 UserRights (9) -
H-“ ¢ ARS (1) Complexity [] Visually Differentiate External Call
i Location (0) ) . . .
ﬂ Authorization Code High Quality Conferencing
+-52p |PO SP EXP RTCP Collector Configuration Directory Overrides Barring
[T] Send RTCP te an RTCP Collector i
[ Advertise Callee State To Internal Callers
: A4
< >
oK Cancel Help
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5.3. VoIP Security Settings

When enabling SRTP on the system, the recommended setting is Preferred. In this scenario, IP
Office uses SRTP if supported by the other end, and otherwise uses RTP. If the Enforced setting is
used, and SRTP is not supported by the other end, the call is not established.

Individual SIP lines and extensions have media security settings that can override system level

settings. This can be used for special cases where the trunk or extension setting must be different
from the system settings.

In the compliance testing, Preferred is set at system, trunk and extensions level to allow the system
to fall back to non-secure media in case there is an issue with SRTP. This would help to avoid
blackout situation within the enterprise network. In some specific deployments, if supported,
Enforce is set at the trunk level to ensure the secured communication over the public internet using
both signaling (TLS) and media (SRTP). Navigate to System - VolP Security tab and configure as
follow:

e Select Preferred for Media Security. The system attempts to use secure media first and if

unsuccessful, falls back to non-secure media within Avaya IP Office system.
e Other parameters are left as default.
e Click OK.

Configuration ‘EE SEQTVM £ v <>

=R BOOTP ()
+-i#% Operator (3)

Systern  LANT  LANZ  DNS Voicemail Telephony Directory Services  System Events  SMTP  SMDR  VolP
-5 Solution VolIP Security  Contact Center
w-§  User(30)
+-58 Group(1) Media Preferred v [ Strict SIPS
+-@% Short Codef43)
----- o= Directory(0)
-7 Time Profile(0)

""" ? Account Code(0) Media Security Options
+-g5 User Rights(9) )
..... 58 Location(0) Encryptions RTP
=% SEQT VM RTCP
m}zrstseggs‘j‘lfm Authentication RTP
-7 Line (2) RTCP
<=2 Control Unit (8) Replay Protection
54 Extension (6) SRTP Window Size 64
+: User (7) ]
.,a Group (0) Crypto Suites
+“ Short Code (50) SRTP_AES_CM_128_SHAT_80
-~ Service (0) SRTP_AES_CM_128_SHA1_32

-3 Inceming Call Rov
wm Directory (0)

i Time Profile (0)
+-ll IP Route (1) —_
- Account Code (0) e

5.4. Administer SIP Line

A SIP line is needed to establish the SIP connection between IP Office and Gamma SIP Trunking
service. The recommended method for configuring a SIP Line is to use the template associated with
these Application Notes. The template is an .xml file that can be used by IP Office Manager to create
a SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line from the template.
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Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

IP addresses.

SIP Credentials (if applicable).

SIP URI entries.

Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Section 5.4.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.

Alternatively, a SIP Line can be created manually. To do so right-click Line in the Navigation Pane
and select New - SIP Line, then follow the steps outlined in Sections 5.4.2.

5.4.1. Create SIP Line from Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to GIPO10101SBC721.xml.

2. Import the template into IP Office Manager.
From IP Office Manager, select Tools = Import Templates in Manager. This action will
copy the template file into the IP Office template directory. The default template location is
C:\Program Files\Avaya\lP Office\Manager\Templates.

File Edit View | Tools | Help

:;I |: Extension Renumber...

SEQT VM Export G -
] Server Edition Service User Management
Configuratic SEQTVM
Busy on Held Validation

T---a BOOTP (12}
4:----:_"- Operator (3) MSM Configuration bi Seri 5 . Sy
.y H Cemal elephon irecto EMVICES stemn Ewvents o

Iy solution Print Button Labels ny 5 &

+-§  User(31) :

+,§ Group(1) | Import Templates in Manager ~ [] Strict 5IPS

-8 Short Code( License Migration

i—-atm Directory(0)

i 7 Tirne Drofile(0 T

In the pop-up window that appears (not shown), select the directory where the template file is
copied in Step 1. After the import is complete, a final import status pop-up window will
appear (not shown) stating success or failure. Then click OK (not shown) to continue. If
preferred, this step may be skipped if the template file is copied directly to the IP Office
template directory.

3. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New - New from Template
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Configuration

=

=R BOOTP (12)

t]-4% Operator (3)
[=-%%0 Solution

E-@ User(31)
[+-5@ Group(1)
(8% Short Code(45)
----- = Directory(0)
1 Time Profile(0)

..... & Account Code(0)
E-§ User Rights(9)
----- 5% Location(D)

Export as Template

SIP Line - Line 19 == N %
SIP Line Transport SIPURI Vol SIP Credentials SIP Advanced Engineering
URl Groups Local URI  Contact Display Mame  Identity Header OCriginator Mumber Send Caller ID Diversion Hi
1 19 19  <Internal> <Internal> <Internal> <|nternal= PAl Diversion MNene
MNew 3
Cut Crl+X
Copy Ctrl+C
Paste Ctrl+V
" Delete Ctrl+Del
Validate
Mew from Template 3 Open from file |

T

Add...

Remove

Edit...

4. On Open pop-up windows, Navigate to Manager > Templates, make sure Template File
(.xml) is the file type selected. Then select the file GIPO10101SBC721.xml. Click Open
and OK (not shown).

I Open
- v 4
Organize ~

4 Quick access
[ Desktop

‘ Downloads
25| Documents

&= Pictures

termplate

I Desktop
f@a Onelrive
2 Quang
= This PC

MNew folder

How to commar
IPO10SBCETT
IPO10SBCETT

« Awvaya » IP Office » Manager ¥

manager_files > template

~ MName

de-DE

en-US

es- WX

fr-FR
IPSET-UMISTIM-CTM
it-IT
LVMGreeting
manager_files
MemoryCards
nl-ML
Phonelmages
pt-BR

ru-RU
Templates

V3_2 999
zh-Hans

n

File name:

Search template gl
=~ M @
Size
~ | Template Files (*xml) ~

Cancel

5. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration

shown in Section 5.4.2.
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5.4.2. Create SIP Line Manually
To create a SIP line, begin by navigating to Line in the left Navigation pane and then right click to
select New > SIP Line. On the SIP Line tab in the Details pane, configure the parameters as
shown below:
e Set ITSP Domain Name to the enterprise domain so that IP Office uses this domain as the
host portion of SIP URI in SIP headers such as the From header.
e Check the In Service box.
e Check the Check OOS box. With this option selected, IP Office will use the SIP OPTIONS
method to periodically check the SIP Line.

e Incoming Supervised REFER is set to Never to allow IP Office to support call transfer
using re-INVITE. REFER method is not supported by Gamma.

e Outgoing Supervised REFER is set to Never to allow IP Office to support call transfer
using re-INVITE. REFER method is not supported by Gamma.

e Other parameters are set as default values.

e Click OK.
Configuration | SIP Line - Line 19 e -8 X | v <
+a BOOTP (10) # 1 SIP Line Transport SIP URI VolP  SIP Credentials SIP Advanced Engineering
+-4% Operator (3)
=% Solution Line Number 19 = In Service
-§  User(31)
-3 Group(1) ITSP Domain Name [avayalab.com | checkoos
+- 8% Short Code(45]
-8 Directory(0) Local Domain Mame | |
- Tirme Profile(0) Session Timers
-l Account Code URI Type Sl s

T i o] Refresh Method Auto

i Location(0) Location Cloud

e Timer (sec) On Demand
Prefix

International Prefix

| |
Mational Prefix | |
| |
| |

) Country Code Redirect and Transfer
; Control Un | ing 5 ised REFER M
+-4 Extension ( Name Priority System Default o ncoming Supervise ever &
+: User (8) . . W
ﬂ Group () Description | | Outgoing Supervised REFER Mever
4-@% Short Code Send 302 Moved Temporarily O
-9 Service (0) Outgoing Blind REFER O
Incoming €
Directory ((
I Time Profil < >
; IP Route (1.
i@ Account Ci v Help
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Select the Transport tab and enter the following information.
e The ITSP Proxy Address is set to the internal interface of Avaya SBCE.
e Layer 4 Protocol is set to TLS.
e Send Port is set to the port number of IP Office, 5061.
e Use Network Topology Info parameter is set to None.
e Other parameters retain default values in the screen below.

e Click OK.

Configuration | T SIP Line - Line 19* =R R AR
a BOOTP (12) SIP Line Transport SIP URI VolP  SIP Credentials SIP Advanced Engineering
+-¢#% Operator (3)
=22 Selution ITSP Proxy Address |10.10.97.176 |

B-§  User(31)

(-5 Group(1)
(18X Short Code(45)

""" ;‘f‘-\ Directory(0) Layer 4 Protocol TLS ~ Send Port (3061

Metwork Configuration

=
3
m
o
g
ES
o
=2
]| [[4]x

Account Code(0) Use Network Topology Info | Nene v Listen Port 3061
[-§5 User Rights(9)
""" i Location(0) Explicit DS Server(s) o .0 .0 .00 . 0 . 0 . 0
[=-%=p SEQT VM

Calls Route via Registrar

Separate Registrar |

OK Cancel Help
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A SIP URI entry Channel 1 is created to match incoming numbers that IP Office will accept on this
line. Select the SIP URI tab, click Add button and then New Channel area will appear at the bottom
of the pane. To edit an existing entry, click an entry in the list at the top, and click the Edit... button.
In the example screen below, a previously configured entry is edited. For the compliance test, a
single SIP URI entry was created that matched any DID number assigned to an IP Office user. The
entry was created with the parameters shown below:

Set Local URI, Contact and Display Name to Use Internal Data. This setting allows to use
the number that IP Office is using to make the call as the From field. The number will be
aligned with IP Office internal number schema.

Set Identity to Use Internal Data and Header to P Asserted ID for Identity.

Set Send Caller ID to None for Forward and Twinning.

Set Diversion Header to None.

Associate this line with an incoming line group in the Incoming Group field. This line
group number will be used in defining incoming call routes for this line. Similarly, associate
the line to an outgoing line group using the Outgoing Group field. For the compliance test, a
new incoming and outgoing group 19 was defined that only contains this line (line 19).

Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern.

Other parameters retain default values and or set according customer requirements.

Click OK.

SIP Entry Channel 1 is shown below.

Configuration | = SIP Line - Line 19 gk - | K| v | <

- @% Sh

el

("‘ Time Profile(0) # | SIP Line Transport SIP URI yolP SIP Credentials 5IP Advanced Engineering
----- #m Account Code(0)
[ ﬁ‘, User Rights(8) URI  Groups Local URI  Contact Display Name ldentity Header Originator Mumber  Send Caller ID Diversion He Add...
----- 5 Location(0) 1
=-==F SEQT VM

+]- S System (1)
Line (8)

G- Contral Unit (11) Cancel
[H-48 Extension (8) Contact |Use Internal Data vl

m-f§  User(9)
..... ﬁ Group (D) Display Mame |Use|nterr‘|a| Data v|

----- B Service (0)
-8 Incoming Call Re ldentity |Use Internal Data V|
~am Directory ()
£ Tire Profile (0) Header P Asserted ID ~
-l IP Route (1) . o
..... & Account Code (0 Forwarding And Twinning
..... % License (38) Originator
i-fa User Rights (9) Number
- ARS (1)
..... &8 Location (0) Send Caller ID Mone -
----- ﬁ Authorization Cc
[=)-%=p |PO SP EXP

[H-%5F Systemn (1)
-4 Line (5) o
-2 Control Unit (3) Diversion Header |Nnr‘|e b
-4 Extension (24)

H-§  User (26)

- 5% Group (1) Incoming Group 19 ~

(- 8% Short Code (64)
""" @ Service (0] Cutgoing Group 1% ~
H-alfe RAS (1)
- Incoming Call Re Max Sessions 10 =

19 19 <Internal> <Internal> =<Internal> <Internal> PAI

Remove

Edit...

Edit LRI

W W g =

0K

19 Local URI |U5e Internal Data v|

ort Code (32) Identity

Registration 0: «None> ~

QT;R
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Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified.

e Selecting G.711 ALAW codec supported by the Gamma SIP Trunking service, in the Session

Description Protocol (SDP) offer.

e Set Fax Transport Support to T38 from the pull-down menu.
e Set the DTMF Support field to RFC2833/RFC4733 from the pull-down menu. This directs
IP Office to send DTMF tones using RTP events messages as defined in RFC2833.

e Check the Re-invite Supported box.

e Check the PRACK/100rel Supported box.
e Media Security is set to Same as System (Preferred) and check the Same As System

checkbox.
e Default values may be used for all other parameters.
e Click OK.
Configuration e SIP Line -Line 19 &k - «

-8 Directory(0)

- Time Profile(0)
Bl Account Code(0)
3 User Rights(9)

- 459 System (1)
=7 Line (7)
g, 1

+-<2 Control Unit (11}
H-4p Extension (7)

i-§  User (8)

.ﬂ Group (0)

+-@% Short Code (31)
G Service (0)

-3 Incoming Call Rout
- Directory (0]

£ Time Profile (0)
+-Jill IP Route (1)

-l Account Code (0)
W License (38)

-3 User Rights (3)
H- g ARS (1)

&% Location (0)

-8 Authorization Code
=l-%%p PO SP EXP

+-559 System (1)

474 Line (3)

*-<= Control Unit (3)

448 Extension (24)
H-§  User (26)

+1a Group (1)
+-@% Short Code (64)

SIP Line Transport SIP URI VelP

Codec Selection Customn

Unused

G.722 64K

G.711 ALAW 64K

G.729(a) 8K C5-ACELP

Fax Transport Support | T38

DTMF Support

Media Security

RFC2833/RFC4733

Same as Systemn (Preferred)

Advanced Media Security Options

5IP Credentials S|P Advanced Engineering

Selected
G.711 ALAW 84K

Same As System

RTP
RTCP
RTP

RTCP

[ Local Hold Music
Re-invite Supported

[] Codec Lockdown

[ Allow Direct Media Path

Force direct media with phones

PRACK/100rel Supported

+E ;ir?a? 0] Help
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5.5. IP Office Line Server Edition
The IP Office line on Server Edition is created below.

Configuration | IP Office Line - Line 1

R BoOTP(12) ~ | Line  Short Codes VolP Settings
Operator (3)
7 Solution

3

Line Mumber 1

B User(21) =
&5 Group(1) Transport Type WebSocket Server w
(- @% Short Code(43)
----- 2% Directory(0) Metworking Level SCN w
- Time Profile(0)
Account Code(0) Security Unsecured ~
Gateway
Address 410 10 a7 229
Location Cloud ~
Password

Confirm Password

-

(-4 Extension (7]

@ User(3) Description |
ﬁ Group (0}
B Short Code (31) 2

Service (0]
H-§3 Incoming Call Re
----- a4 Directory (0)

Telephone Mumber
Prefix

Qutgoing Group ID
MNumber of Channels

Outgoing Channels

SCN Resiliency Options
[] Supports Resiliency

[ Backs up my IP phones

[J Backs up my hunt groups
[ Backs up my IP DECT phones

>

Help

VoIP Settings tab is required to set for Fax Transport Support as T38 as the SIP trunk to service

provider.
Configuration | = IP Office Line - Line 1 e - Xlwvw]|<]|>
=R BOOTP (12) A | Line  Short Codes VolP Settings
t Operator (3) -
-5 Selution Qut Of Band DTMF
Eiﬁﬁ% :::L(sg) Allow Direct Media Path
[#-8% Short Code(45) Codec Selection Custom ~
----- a5 Dhrectory(0)
-7 Time Profile(0) Unused Selected
.8m Account Code(0) G711 ALAW 64K . G711 ALAW B4K
#-§y User Rights(9) G.722 B4K
-8 Location(0) G.729(a) 8K CS-ACELP
<<
23>
- ’ Fax Transport Support T38 w
(¢4 Extension (7) Call Initiation Timeout (5) 40
E-@ User (8)
03 g}:itltpc(?:le 1) Media Security Same as Systemn (Preferred) ~
Advanced Media Security Options Same As System
W
----- £ Time Profile (0] Help
oo Kl oo hm 1
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5.6. IP Office Line Secondary Server

The IP Office Lines are automatically created on each server when a Secondary server or Expansion
System is added to the solution. Below is the IP Office Line to the Primary server.

Configuration

H—

Line =

= IP Office Line - Line 17

R BOOTP (12)

Operator (3)

' Solution

----- § User(31)

..... .ﬂ Group(1)

----- 8% Short Code(45)
----- == Directory(0)

£ Time Profile(0)
----- #m Account Code(0)
----- 5 User Rights(g)

""" i@ Location(0)

- SEQT VM

----- <2 Control Unit (11)
----- 4 Extension (7)

..... a User (8)

..... a Group (0)

----- BX Short Code (51)
----- B Service (0)

..... #u Directory (0)
..... £ Time Profile (0)
..... @l IP Route (1)

----- @ Incoming Call Route

Line Mu...
™
42
T3
114

- 17

Line Type Line  Short Codes VolP Settings T38 Fax
Analogue Trunk
Analogue Trunk Line Number 7

Analogue Trunk Transport Type
Analogue Trunk

IP Office Line Metworking Level SCHN

Security Unsecured

Gateway

Address 133 10
Location Cloud

Password

Confirm Password

WebSocket Client

97 61

Telephone Number
Prefix

Outgoing Group D
MNumber of Channels

Outgeing Channels

Port

SCM Resiliency Options

[] Supports Resiliency

[ Backs up my IP phones

[ Backs up my hunt greups

Help

In this testing configuration, a fax machine is connected to one of the analog ports on the Expansion
System. To accommodate T.38 fax, select the VolP Settings tab and configure the following:

e Select T38 for Fax Transport Support.

Configuration |

=

= IP Office Line - Line 17

ef - X v«

=

|- & BOOTP (12)

Operator (3)

< Solution

H-§  User(31)

H-5a@ Group(1)

8% Short Code(45)
Directory(0)

! Time Profile(0)
#m Account Code(D)
H-§i5 User Rights(9)

""" & Location(0)

3}

2 17|
[+ Control Unit (3)
(-4 Extension (24)
G-§  User (26)
(-5 Group (1]
(18X Short Code (64)

(ol RAS (1)
E]---@ Incoming Call Route
----- 8 WAN Port (0)

Line  Short Codes VeolP Settings T38 Fax

Codec Selection Custom o
Unused Selected
G711 ALAW 64K s G711 ALAW 84K
G.723.1 6K3 MP-MLC
G.728(a) 8K C5-ACELP
<<€
EES
Fax Transport Support T38
Call Initiation Timeout () 40 S
Media Security Same as System (Preferred) ~

Advanced Media Security Options

Same As System

[] VolP Silence Suppression
Out Of Band DTMF

Allow Direct Media Path

~

f;‘ Time Profile (0) Help
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5.7. Short Code

Define a short code to route outbound traffic to the SIP line. To create a short code, select Short
Code in the left Navigation pane, then right-click in the Group pane and select New. On the Short
Code tab in the Details pane, configure the parameters for the new short code to be created. The
screen below shows the details of the previously administered “8N;” short code used in the test
configuration.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 8N, this short code will be invoked when the user dials 8 followed by any
number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to the value shown in the capture below. This field is used to
construct the Request URI and To headers in the outgoing SIP INVITE message. The value
N represents the number dialed by the user.

e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on the
SIP Line in Section 5.4. This short code will use this line group when placing the outbound

call.
e Others parameters are at default values.
e Click OK.
Configuration | Short Code 8N;: Dial e - X |wvw|<]->
----- % Group(1) A | Code TelephoneNu ™ || Short Code
----- % Short Code(43) BX*55
Directory(0) R Code aN;
! Time Profile(0) “*SF*N-{“ N | |
Account Code(0) BXEETNE N Feature Dial ~
..... §| User Rights(3) MHETFNE N
..... 55 Location(D) BXTINE N Telephone Mumber |+N |
=% SEQT UM o%°99,  “edi i
: ! System (1) “4le 4; it_message Line Group |D |19 v|
| E"‘et(gllu i oxXeN: N Locale United Kingdom (UK English) ~
ontrol Uni ’
& Extension (8) BATN; N Force Account Code O
E“ gser (910] ::E:' ;N Force Autharization Code []
roup
- @% Short Code (52) BXENFOD 00 ]
@ Senvice (0) < > Help
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For incoming calls from mobility extension to FNE (Feature Name/Number Extension) features
hosted by IP Office to provide dial tone functionality, Short Code FNEOO was created. The FNEOO
was configured with the following parameters.

e Inthe Code field, enter the FNE feature code as FNEQO for dial tone.

e Set the Feature field to FNE Service.
e Set the Telephone Number field to 00.
e Setthe Line Group ID field to 0.

e Retain default values for other fields.

e Click OK.
Configuration Short Code T FNEO0O: FNE Service* [ X v«
~ & BOOTP (12) Code Telephone M ™ || Short Code
Operator (3) oM =49
----- § User(31) “fo
..... ﬂ Group(1) 51 Feature FME Service ~
----- 8% Short Code(45) =52
,,,,, 2= Directory(D) BX53*NE N Telephone Number
£ Time Profile(0) %55 : _
..... ? Account Code(0) PN N Line Group ID 0 ~
----- 3 User Rights(9) emEAs Local o
----- E' Location(0) %756 N"‘_* N e
-39 SEQT VM WOTONE N Force Account Code [l
H‘_ S}tstem (1 WTINE N Force Authorization Cede [
""" T4 Line (7) % +g0: "edit_messa;
..... & E;tntr0.| UrEg:J (11) @X 6N M
""" C ension L/
----- § User(® 97N, N
..... ﬂ Group (0) |- LER +MN
----- 8% Short Code (51) xoN N
----- B Service (0) @XFNEOD 0D
----- ) Incoming Call Route (7) h oK Tepad Help
----- a5 Nirectons (M < L4 = = =
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5.8. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.4. To configure these settings, first select User in the left Navigation pane, then
select the name of the user to be modified in the center Group pane. In the example below, the name
of the user is “H323-2550". Select the SIP tab in the Details Pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line (Section 5.4). The
example below shows the settings for user H323-2550.
e The SIP Name and Contact are set to one of the DID numbers assigned to the enterprise
from service provider.
e The SIP Display Name (Alias) parameter can optionally be configured with a descriptive
name.
o If all calls involving this user and a SIP Line should be considered private, then the
Anonymous box may be checked to withhold the user’s information from the network.
e Click OK.

Configuration | User H = H323-2550: 2550 &f - X v <> &
""" ’a Group(1) A | Name Extension User Voicemail DMD Short Codes  Source Mumbers  Telephony Ferwarding  Dial In
""" 8% Short Code(45) =,.,2559 2559
- Directory(0) ﬂHHBB-ESSD o Voice Recording  Button Programming  Menu Programming  Mobility  Group Membership
""" ("‘ Tirne Profile(0) =HH323 3551 2551 Announcements  SIP Personal Directory  Web Self-Administration
----- | Account Code(0) B ~
..... §5 User Rights(a) frH323-2552 2552 5IP Mame |+44122931?455 |
----- &3 Location(0) :NDUSE{ ] )
=% SEQT VM §5ips-2555 2555 SIP Display Mame (Alias) |H3Z3—2550 |
o ey dsips-2556 2556 Contact [<aan229317455 |
""" 4 Line (8) §rsips-2557 2557
----- <2 Control Unit {11) e '
..... & Extension (8) grsips-2558 2558
..... : User (9) [] Anonymous o
----- :ﬂ Group (0) < >
----- 8% Short Code (52)
..... 4} Ser\rlce_ ()] Help
----- e Incoming Call Route < >
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One of the H.323 IP Phones at the enterprise site uses the Mobile Twinning feature. The following

screen shows the Mobility tab for User H323-2550.

e The Mobility Features and Mobile Twinning boxes are checked.

e The Twinned Mobile Number field is configured with the number to dial to reach the

twinned mobile telephone, in this case 816137717498.

e Enable Mobile Call Control to allow any mobile phone user to access IP Office features

without using the one-X Mobile client application.

e Other options can be set according to customer requirements.

e Click OK.

Configuration | User = H323-2550: 2550 - X vi<l> &
BOOTP (12) Alff Name Etensio User Voicemail DMND Short Codes  Source Numbers Telephony Forwarding Dial In - Voice Recording
Operator (3) §-2559 2559

= Solution ﬂHHBB T 2 Personal Directory  Web Self-Administration
@ User(32) f-Ha222551 2551 Button Programming  Menu Programming  Mobility  Group Membership  Announcements  SIP
4§ Group(1) -
--@% Short Code(45) &HH323-2552 2552 [ Intemal Twinning
a8 Directory(0) :NUUSEF <MNone>
£ Time Profile(0) §rsips-2355 2555
: ;‘ Account Code(0) §rsips-2556 2556 1
-5 User Rights(9)
.. ﬁ' Location(0) frsiPs-2557 2557 Twin Bridge Appearances
O SIPS-2558 2358
1= SEQT VM Ly Twin Coverage Appearances
System (1)
4 Line (8) Twin Line Appearances
= Control Unit (11}
-4 Extension (3) Mobility Features
~§ User(9) Mobile Twinning
ik Group (0) . .
9% Short Code (52) TWII'H'Ie.d Mo.blle MNumber |ST 6127717498
@ Service (0) (including dial access code)
@ Inceming Call Reute (8) Twinning Time Profile <None> |
a4 Directory (0)
£ Tirme Profile (0) Mobile Dial Delay (sec) |2
Kl 1P Route (1) =
0
.8m Account Code (0) Mobile Answer Guard (sec) =
R License (38) [ Hunt group calls eligible for mobile twinning
-f5 User Rights (9)
¢ ARS (1) [ Forwarded calls eligible for mobile twinning
8 Location (0 [] Twin When Logged Qut
m Authorization Code ()
=3 |PO SP EXP one-X Mobile Client
g System (1) :
4 Line (3 Mobile Call Control
= Control Unit (3) [] Mobile Callback
48 Extension (24)
~§ User(26) ( >
8 Group (1)
#% Short Code (64)
i Hel
@ Service (0] < > Delp
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5.9. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, select Incoming Call Route in the left Navigation pane, then right-click in
the center Group pane and select New. On the Standard tab of the Details pane, enter the

parameters as shown below:

e Set the Bearer Capacity to Any Voice.
e Setthe Line Group Id to the incoming line group of the SIP line defined in Section 5.4.
e Set the Incoming Number to the incoming number on which this route should match.
e Default values can be used for all other fields.

e Click OK.
Configuration | Incoming Call Route ||i= 19 +441229317455 e -
‘,‘ BOOTP (12) # | Line GroupID  Incoming Numbe|  Standard oice Recording  Destinations
. g]plerlator 3 @5 2049924602
@lution @5 2049924500
..... % g::;g(% @1 441229317455 Bearer Capability Any Voice ~
..... 9% Short Code(45) (3L +441220317458 || [ine Group ID |19 v|
----- 2 Directory(0) @19 +441229317457
-4 Time Profile(0) @19 6132606508 Incoming Number |+44122931?455 |
----- A t Code(0]
----- i User Ri htD(QJE( : @19 AN || jncoming Sub Address | |
' ghts
""" &5 Location(0) @ 6132606506 .
s SEQT VM Inceming CLI | |
-5 System (1) Locale -
----- 9 Line (8)
----- < Control Unit (11) Priority 1-Low ~
----- 4 Extension (8)
----- a User (9) Tag | |
..... .ﬂ Group (0) .
..... % Short Code (52) Held Music Source System Source ~
----- @ Service (0) . )
_____ @ Incoming Call Route (8) Ring Tone Override |N0ne v|
On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. In this example, incoming calls to +441229317455 on line 19 are routed to
extension 2550. Click OK.
Configuration | Incoming Call Route || = 19 +441229317455 e - X|vl|=<]|>
’S EOOTP (1(23]) ~ | LineGroup ID Incoming Numb¢| Standard voice Recording  Destinations
-7 Operator
8 zme
% g::[ls(?) D0 +441229317455 Bearer Capability Any Voice ~
B Short Code(45) @1 +A1229317458 || |ine Group ID [19 ~|
.o Directory(0) @19 +441229317457
41 Time Profile(0) @19 6132606508 Incoming Number +441229317435 |
am A Code(0
- User ;i:thtso(g)E( : @1 +AM22TTAZ6 || | caming Sub Address | |
&8 Location() P1o 6132606506
i EQT VM Incoming CLI | |
) Syste(r; 1 Locale ~
{ Line
Control Unit (11) Priority 1-Low s
& Extension (8)
User () Tag | |
Group (0)
BX Short Code (52) Hold Music Source System Source ~
B service (0) ) )
e Incoming Call Route (8) Ring Tone Override |N0ne v|
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5.10. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

5.11. IP Office TLS Certificate Management

This section provides a procedure on how to download IP Office certificate which is being installed
on Avaya SBCE for the communication between Avaya system’s components using TLS
connectivity.

To download IP Office certificate, launch a web browser and log in Avaya IP Office Web
Management as shown below.

m Avaya IP Office Web Ma x

“~ C' | & https://10.10.97.61:7070/WebManagement/WebManagement.htm ? ¢ m =

Avaya IP Office Web Manager

User Name Administrator

Password = eeessesssscsse

Select Language English N

Offline Mode (i ]

® 2016 Avaya Inc. All Rights Reserved.
A
On Solution page, click on drop-down menu on the right and select Platform View as shown.
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ANVAYA

% Solution Call Management  System Settings  Security Manager  Applications
Solution Solufion Setfings ~
LUT DBJECTS
View All (2) Actions - Configure ~
@ SEQT VM 135.10.97.61 = ~
B \ Dashboard
Online (2) @ IPO SP EXP 135.10.97.229 v
Offline (0) Flatform View
Backup
. Restore
Servers (1)
Expansions (1) On-boarding
Application Servers (0) Launch 554
Service Commands
Initial Configuration
Download Configuration
View Upgrade Report

On Platform page, click on Settings and scroll down to Certificates section. At CA Certificate
section, click on the Download (PEM-encoded) button to obtain the IP Office CA certificate.

AVAYA
% Solution Call Management  System Settings  Security Manager = Applications
Platform - | 10.10.97.61 | &
Settings
I System
Certificates CA Certificate -
Create new '® Renew existing Import Export
Regenerate Download (PEM-encoded) Download (DER-encoded)
Identity Certificates
¥| Renew automatically
Warning: The certificate will be automatically regenerated and replaced for all applications, when a change that causes
itto expire (such as network or LAN change) takes place. This will cause all applications to restart, and you will be
redirected to the login page.
Create certificate for a difierent machine
Subject Name: 000C20ESBESG
Subject Alternative Name(s): DNS:000C29E8BERG, IP:10.10.97 51, IP:192.168.43.1
Duration (days). 2555
Public Key Algorithm: RSA-2048 v
Secure Hash Algorithm: SHA-256 v
Fegenerate and Apply Download (PEM-encoded) Download (DER-encoded) 7’1
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6. Configure the Avaya Session Border Controller for
Enterprise

This section covers the configuration of the Avaya SBCE. It is assumed that the software has already
been installed. For additional information on these configuration tasks, see Section 10.

The compliance testing comprised the configuration for two major components, Trunk Server for the
service provider and Call Server for the enterprise. Each component consists of a set of Global
Profiles, Domain Policies and Device Specific Settings. The configuration was defined in the Avaya
SBCE web user interface as described in the following sections.

Trunk Server configuration elements for the service provider - Gamma:
e Global Profiles:
o URI Groups
o Routing
Topology Hiding
o Server Interworking
o Server Configuration
e Domain Policies:
o Application Rules
o Media Rules
o Signaling Rules
o Endpoint Policy Group
e TLS Management
o Certificates
o Client Profiles
o Server Profiles
e Device Specific Settings:
o Network Management
o Media Interface
o Signaling Interface
o End Point Flows - Server Flows

O

Call Server configuration elements for the enterprise - IP Office:
e Global Profiles:
o URI Groups
o Routing
Topology Hiding
o Server Interworking
o Server Configuration
e Domain Policies:
o Application Rules
o Media Rules
o Signaling Rules
o Endpoint Policy Group
e TLS Management

o
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o Certificates
o Client Profiles
o Server Profiles
e Device Specific Settings:
o Network Management
o Media Interface
o Signaling Interface
o End Point Flows - Server Flows

6.1. Log into the Avaya Session Border Controller for Enterprise

Use a Web browser to access the Avaya SBCE Web interface, enter https://<ip-addr>/sbc in the
address field of the web browser, where <ip-addr> is the management IP address.

Enter the appropriate credentials then click Log In.

AVAYA =

Continue
WELCOME TO AMAYA SBC

Unauthorized access to this machine iz prohibited. This system is for the

SeSSion Bord er ContrOIler use authorized users only. Usage of this system may be monitored and
for Enterprise recorded by system personnel.

Anyone using thiz system expresshy consents to such moenitoring and is
advised that if such monitoring reveals possible evidence of criminal
activity, =swystem perzonnel may provide the evidence from =such
monitoring to law enforcement officials.

& 2011 - 2017 Awawa Inc. All rights reserved.

The Dashboard main page will appear as shown below.

DPashboard
Bdministration
Packup/Restore
Bystem Management

Global Parameters
Global Profiles
PPM Services
Domain Policies

TLS Management

Device Specific Settings

Session Border Controller for Enterprise AVAYA

Dashboard ~

This system contains one or more Avaya demo certificates. These certificates have been compromised and

should not be used for any production traffic.

Information

Installed Devices

System Time 10:04:23 AM GMT Refresh EMS
Version 7.2.1.0-05-14222 mSBCE
Build Date Tue Oct 31 00:06:46 UTC 2017

License State S OoK

Aggregate Licensing Overages 0

Peak Licensing Overage Count 0

Last Logged in at 03/05/2018 08:33:42 GMT

Failed Login Attempts 0
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6.2. TLS Management

Note — Testing was done using identity certificates signed by a local certificate authority. The
procedure to create and obtain these certificates is outside the scope of these Application Notes.

Transport Layer Security (TLS) is a standard protocol that is used extensively to provide a secure
channel by encrypting communications over IP networks. It enables clients to authenticate servers
or, optionally, servers to authenticate clients. The Avaya SBCE utilizes TLS primarily to facilitate
secure communications with remote users.

Avaya SBCE supports the configuration of third-party certificates and TLS settings. For optimum
security, Avaya recommends using third-party CA certificates for enhanced security.

In this compliance testing, TLS transport is used for the communication between IP Office and
Avaya SBCE. The following procedures show how to create the client and server profiles.
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6.2.1. Certificates

You can use the certificate management functionality that is built into the Avaya SBCE to control all
certificates used in TLS handshakes. You can access the Certificates screen from TLS Management

- Certificates.

Ensure the certificates are presented in the system as shown below.
e AvayaSBCCA.crt is Avaya SBCE Certificate Authority root certificate.
e SEQT_VM ca.pem is IP Office root certificate obtaining from Section 5.11.

Session Border Controller for Enterprise

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

> Global Profiles

> PPM Services

> Domain Policies

4 TLS Management
Certificates
Client Profiles
Server Profiles

> Device Specific Settings

Certificates

Install Generate CSR

Certificates

AVAYA

sheeky.crt View Delete
AvayaSBC.crt View Delete
VeriSignClass3PublicPrimary CertificationAuthority-G4 .cer View Delete
Line_System_CA.crt View Delete
AvayaSBCCA crt View Delete
SEQT_VM_ca.pem View Delete
IP0O210.pem View Delete

Installed Certificate Revocation Lists

No certificate revocation lists have been installed.

AvayaSBC key Delete
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If IP Office Certificate Authority certificate (SEQT_VM_ca.pem) is not present, the following
procedure will show how to install it here on Avaya SBCE.

IP Office CA certificate is obtained using procedure provided in Section 5.11. Then on Avaya
SBCE, navigate to TLS Management - Certificates. Click on Install button.
e Select CA Certificate.
e Provide a descriptive Name. In the example below, the Name field was left empty and
default name was used as root-ca.pem.
e Browse to the directory where the IP Office CA was previously saved and select it.
e Click Upload.

Install Certificate

O Certificate
Type ® CA Certificate
O Certificate Revocation List

MName |

Overwrite Existing O

Allow Weak Certificate/Key O

Certificate File SEQT_VM_ca.pem

Upload

6.2.2. Client Profiles

This section describes the procedure to create client profile for Avaya SBCE to communicate with IP
Office via TLS signalling. This client profile will be used in Section 6.3.3.2.

To create Client profile, navigate to TLS Management - Client Profiles, click Add.

e Enter descriptive name in Profile Name.

e Select AvayaSBC.crt from pull down menu of Certificate.

e For Peer Verification, select IP Office CA certificate which was installed from above
section.

e Enter 1 as Verification Depth.

e Click Next (not shown).

e Select Custom for Ciphers in Cipher Suit Options section. And Value ALL is specified in
the capture shown below.

e Click Finish (not shown)
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Capture below illustrates a client profile being created on Avaya SBCE.

Dashboard

Administration

Backup/Restore

Systerm Management

> Global Parameters

> Global Profiles

> PPM Services

> Domain Policies

4 TLS Management
Certificates
Client Profiles
Server Profiles

> Device Specific Settings

Session Border Controller for Enterprise

Client Profiles: EN-CP
Add Delete
Client Profiles Click here to add a description.
ClientTLS_IPO
- Client Profile

EN-CP

SP-CP The certificate in this TLS Profile is known to have been compromised and should not be used in
a production environment.

AvayaSBCCli_..
TLS Profile

TelnyxCP Profile Name EN-CP

I B Certificate AvayaSBC_crt

TLS_sbce_pr...

Avaya_|IPO14
Peer Verification Required

Line_System...

Peer Certificate Authorities
Peer Certificate Revocation Lists
Verification Depth

Extended Hostname Verification

Renegotiation Parameters

Renegotiation Time

Renegotiation Byte Count
Handshake Options
Version

Ciphers

Value

SEQT_VM_ca.pem

1

812 TLS 11 TLS 1.0
Default FIPS Custom
ALL
Edit

6.2.3. Server Profiles
This section describes the procedure to create server profile for Avaya SBCE to communicate with

IP Office via TLS signalling. This will be used in Section 6.5.3.

To create Server profile, navigate to TLS Management - Server Profiles, click Add.
e Enter descriptive name in Profile Name.

the capture shown below.
e Click Finish (not shown).
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Session Border Controller for Enterprise

Dashboard
Administration

Server Profiles: EN-SP

Add
Backup/Restore

System Management ———

SemverTLS-IPO

> Global Parameters Server Profile

AVAYA

Delete

Click here to add a descnption.

i
[ Server Profe |

> Global Profiles SMGR Cert
| .
> PPM Services TLS.5P cetl _
» Domain Policies a production environment.
4 TLS Management AvayaSBCSe... TLS Profile
Certificates EN-5P Profile Name
Client Profiles
IPO42 :
Certificate
Server Profiles
] N _ SP-SP
> Device Specific Settings Cestificate Venficzation
IPO14
Peer Verification
AvayaSBCSe...

Extended Hostname Verification

Renegotiation Parameters

Renegotiation Time

Renegotiation Byte Count
Handshake Options
Version

Ciphers

Value

The certificate in this TLS Profile is known to have been compromised and should not be used in

EN-SP

AvayaSBC.crt

MNaone

TLS 1.2 TLS 1.1 TLS 1.0

Default FIPS Custom

ALL

Edit
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6.3. Global Profiles
Global Profiles allows for configuration of parameters across all Avaya SBCE appliances.

The naming convention used in this entire section is as follows:
e SP stands for Service Provider, which is Gamma in this case.
e EN stands for Enterprise Network, which is referred to Avaya IP Office.

6.3.1. Uniform Resource Identifier (URI) Groups

URI Group feature allows user to create any number of logical URI groups that are comprised of
individual SIP subscribers located in that particular domain or group. These groups are used by the
various domain policies to determine which actions (Allow, Block, or Apply Policy) should be used
for a given call flow.

For this configuration testing, “*” is used for all incoming and outgoing traffic.

6.3.2. Server Interworking Profile
Interworking Profile features are configured differently for Call Server and Trunk Server.

To create a Server Interworking profile, select Global Profiles = Server Interworking. Click on
the Add button.

In the compliance testing, two Server Interworking profiles were created for SP and EN respectively.

6.3.2.1 Server Interworking Profile for SP
Profile SP-SI was defined to match the specification of SP. The General, Header Manipulations

and Advanced tabs are configured with the following parameters while the other tabs for Timers,
Privacy and URI Manipulation are kept as default.

General tab:

e Hold Support = NONE. The Avaya SBCE will not modify the hold/ resume signaling from
EN to SP.

e 18X Handling = None. The Avaya SBCE will not handle 18X, it will keep the 18X
messages unchanged from EN to SP.

e Refer Handling = No. The Avaya SBCE will not handle REFER. It will keep the REFER
message unchanged from EN to SP.

e T.38 Support = Yes. SP does support T.38 fax.

e Others are left as default values.
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The screenshots below illustrate the Server Interworking profile SP-SI, General.

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

4 Global Profiles
Domain DoS
Server Interworking
Media Forking
Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups
SNMP Traps
Time of Day Rules
FGDN Groups
Reverse Proxy Policy
RADIUS

> PPM Services

> Domain Policies

> TLS Management

> Device Specific Settings

Add

Interworking
Profiles

cs2100

avaya-ru
0OCS-Edge-Server
cisco-ccm

cups

Sipera-Halo
OCS-FrontEnd-...
IPO
MTSAllstream
EN-SI

RC

ThinkTel

SP-SI

IPO_42

IPO_14

IPO_48

SP4_1

SP4

Session Border Controller for Enterprise

Interworking Profiles: SP-SI

AVAYA

Rename Clone Delete

Click here to add a description.

General U Timers |_| Privacy |_| URI M

ipulati |_|

ipulation || Advanced |

General
Hold Support
180 Handling
181 Handling
182 Handling
183 Handling
Refer Handling
URI Group
Send Hold
Delayed Offer
Jxx Handling
Diversion Header Support
Delayed SDP Handling
Re-Invite Handling
Prack Handling
Allow 18X SDP
T.38 Support
URI Scheme

Via Header Format

NONE
Mone
MNaone
Mone

Mone

RFC3261

Edit
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The screenshots below illustrate the Server Interworking profile SP-SI, Advanced.

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

4 Global Profiles
Domain DoS
Server Interworking
Media Forking
Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups
SNMP Traps
Time of Day Rules
FGDM Groups
Reverse Proxy Policy
RADIUS

> PPM Services

Session Border Controller for Enterprise

Interworking Profiles: SP-SI

Add

AVAYA

Rename Clone Delete

Interworking Click here to add a description.
Profiles

General H Timers H Privacy H URI Manipulation H Header Manipulation H Advanced L

SP-SI
Record Routes Both Sides
Include End Point IP for Context Lookup Mo
Extensions Avaya
Diversion Manipulation Mo
Has Remote SBC Yes
Route Response on Via Port Mo
Relay INVITE Replace for SIPREC Mo
MOBX Re-INVITE Handling Mo
DTMF
DTMF Support Mone

Edit

6.3.2.2 Server Interworking Profile for EN
Profile EN-SI was defined to match the specification of EN. The General and Advanced tabs are
configured with the following parameters while the other settings for Timers, Privacy, URI

Manipulation and Header Manipulation are kept as default.

General tab:

e Hold Support = NONE.

e 18X Handling = None. The Avaya SBCE will not handle 18X, it will keep the 18X
messages unchanged from SP to EN.

e Refer Handling = No. The Avaya SBCE will not handle REFER, it will keep the REFER
messages unchanged from SP to EN.

e T.38 Support = Yes. EN does support T.38 fax.

e Others are left as default values.
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The screenshots below illustrate the Server Interworking profile EN-SI, General.

Session Border Controller for Enterprise AVAYA

Dashboard Interworking Profiles: EN-SI
Administration
Add Rename Clone Delete
Backup/Restore
System Management Ipn::ﬁlrv:{:rking Click here to add a description.
+ Global Parameters 52100 General UTimersH Privacy u URI Manipulati |_| Header Manipulati |_|Ad ed |
4 (Global Profiles
Domain DoS aaya
Server Interworking OCS-Edge-Server Hold Support NOMNE
Media Forking cisco-cem 180 Handling None
Routin
< ) _ cups 181 Handling None
Server Configuration
Topolagy Hiding Sipera-Halo 182 Handling None
Signaling Manipulation OCS-FrontEnd-._. 183 Handling None
URI Groups PO Refer Handling No
SNMP Traps URI Group None
Time of Day Rules (s shean
Send Hold No
FGDN Groups EN-SI
Reverse Proxy Policy RC Delayed Offer No
RADIUS 3xx Handling No
. ThinkTel
> PPM Services Diversion Header Support No
i ici SP-SI
> Domain Policies Delayed SDP Handling No
> TLS Management IPO_42
. = . - Re-Imvite Handling No
> Device Specific Settings =)
- Prack Handling No
IPO_48 Allow 18X SDP No
SP4_1 T.38 Support Yes
SP4 URI Scheme sIP
Via Header Format RFC3261
Edit
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Advanced tab:

e Record Routes = Both Sides. The Avaya SBCE will send Record-Route header to both call
and trunk servers.

e Include End Point IP for Context Lookup = No.

e Extensions = Avaya.

e Has Remote SBC = Yes. This setting allows the Avaya SBCE to always use the SDP
received from EN for the media.

e DTMF Support = None. The Avaya SBCE will send original DTMF method from SP to
EN.

e Others are left as default values.

The screenshots below illustrate the Server Interworking profile EN-SI, Advanced.

Session Border Controller for Enterprise AVAYA
Dashboard Interworking Profiles: EN-SI
Administration
Add Rename || Clone || Delete
Backup/Restore
System Management Interworking Click here to add a description.
Profiles
 Global Parémeters 52100 General |_| Timers |_| Privacy |_| URI Manipulation |_| Header Manipulation H Advanced
4 Global Profiles
Domain DoS avaya-u Record Routes Both Sides
Server Interworking OCS-Edge-Server Include End Paint IP for Context Lookup Mo
Media Forking cisco-ccm Extensions Avaya
Routing
Diversion Manipulati N
Server Configuration cups iversion Manipulation 0
Topology Hiding Sipera-Halo Has Remote SBC Yes
Signaling Manipulation 0CS-FrontEnd-... Route Response on Via Port Mo
URI Graups PO Relay INVITE Replace for SIPREC No
SNMP Traps MOBX Re-NVITE Handli N
el andling 0
Time of Day Rules MTSAllstream
FGDM Groups EN-SI DTMF
Reverse Proxy Policy RC DTMF Sugport None
RADIUS
ThinkTel i
- PPM Services e i

6.3.3. Server Configuration

Server Configuration screen contains four tabs: General, Authentication, Heartbeat, Ping and
Advanced. These tabs are used to configure and manage various SIP Call Server specific parameters
such as TCP and UDP port assignments, heartbeat signaling parameters, DoS security statistics and
trusted domains.

To create a Server Configuration entry, select Global Profiles > Server Configuration. Click Add
button.

In the compliance testing, two separate Server Configurations were created, server entry SP-SC for
SP and server entry EN-SC for EN.
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6.3.3.1 Server Configuration for SP

Server Configuration named SP-SC was created for SP. It will be discussed in detail below. General
and Advanced tabs are provisioned for SP on the SIP trunk for every outbound call from enterprise
to PSTN. Authentication, Heartbeat and Ping tabs are kept as disabled as default (not shown) to
allow the Avaya SBCE to forward the OPTIONS heartbeat from EN to SP to query the status of the
SIP trunk.

General tab: Click the Add button and enter the following information.
e Enter Profile Name SP-SC and click the Next button (not shown).
e Set Server Type for SP as Trunk Server.
e Enter provided IP Address / FQDN of SP. Transport UDP and listened on port 5060.
e Click Next and Next (not shown).

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: SP-SC
Administration
Add Rename Clone Delete
Backup/Restore
System Management General H Authentication H Heartbeat u Ping I_I Advanced |
> Global Parameters EN-SC
) Server Type Trunk Server
4 Global Profiles SP4
Domain DoS . IP Address / FQDN Port Transport
X testing
Server Interworking 192.168.61.201 5060 uppP
Media Forking spP-sC
Routing i

Server Configuration

Advanced tab: Click the Edit button and enter the following information.
e From the Interworking Profile drop down list, select SP-SI as defined in Section 6.3.2.
e The other settings are kept as default. Click Finish (not shown).

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: SP-SC
Administration
Add Rename Clone Delete
Backup/Restore
System Management General |_| Authentication |_| Heartbeat |_| Ping H Advanced
> Global Parameters PO
Enable DoS Protection |

4 Global Profiles RC

Domain DoS . ThinkTel Enable Grooming

Server Interworking Interworking Profile SP-SI

Media Forking 1P0_210 - o

Signaling Manipulation Script Mone

Routing EM-SC

Server Configuration PO 42 Securable U

Topology Hiding PO 14 Enable FGDM O

Signaling Manipulation -

URI Groups SP.SC Tolerant O

SNMP Traps SP4 URI Group Mone

Time of Day Rules ——

FGDN Groups

QT; Reviewed: Solution & Interoperability Test Lab Application Notes 38 of 59

SPOC 3/27/2018 ©2018 Avaya Inc. All Rights Reserved. GIPO10101SBC721



6.3.3.2 Server Configuration for EN

Server Configuration named EN-SC created for EN is discussed in detail below. General and
Advanced tabs are provisioned. The Authentication, Heartbeat and Ping tabs are kept as disabled
as default to allow the Avaya SBCE to forward the OPTIONS heartbeat from SP to EN to query the
status of the SIP trunk.

General tab: Click Add button then specifying the following.

Set Server Type for EN as Call Server and click the Next button (not shown).
IP Address/FQDN is IP Office WAN port IP address.

Transport, between the Avaya SBCE and IP Office was TLS, and Port 5061.
TLS Client Profile is the profile created in Section 6.2.2.

Click Next, Next, Next and Finish (not shown).

Session Border Controller for Enterprise AVAYA
 Global Para_'mEterS Server Configuration: EN-SC
l# Global Profiles
Domain DoS Add Rename Clone Delete
Server Interworking General U Authentication H Heartbeat H Ping H Advanced |
Media Forking EN-SC
Routing Server Type Call Server
Server Configuration TLS Client Profile EMN-CP
Topology Hiding IP Address / FQDN Port Transport
Signaling Manipulation
URI Groups 10.10.97.61 5061 TLS
SNMP Traps Edit
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Advanced tab: Click Edit button then enter the following information.
e From the Interworking Profile drop down list select EN-SI as defined in Section Error!
Reference source not found..
e The other settings are kept as default.

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: EN-SC
Administration
Add Rename Clone Delete
Backup/Restore
System Management General |_| Authentication |_| Heartbeat |_| Ping H Advanced
- Global Parameters IPO
) Enable DoS Protection O
4 Global Profiles RC
i Enable Groomin
Domain DoS , ThinkTel g %
Server Interworking =5 270 Interworking Profile EN-5I
Media Forking = : : : ; -
Signaling Manipulation Script Mane
Routing EN-SC
Server Configuration PO 42 Securable O
Topology Hidin
.p _QY .Q . PO 14 Enable FGDN (!
Signaling Manipulation -
Tal t
URI Groups SP4 oleran =
SNMP Traps SP-SC URI Group Maone
Time of Day Rules =0
EODKM Cronmme

6.3.4. Routing Profiles

Routing profiles define a specific set of packet routing criteria that are used in conjunction with other
types of domain policies to identify a particular call flow and thereby ascertain which security
features will be applied to those packets. Parameters defined by Routing profiles include packet
transport settings, name server addresses and resolution methods, next hop routing information and
packet transport types.

To create a Routing profile, select Global Profiles & Routing then click on the Add button.

In the compliance testing, Routing profile SP-RP was created to be used in conjunction with Server
Flow (see Section 6.5.4) defined for EN. This entry is to route outgoing calls from the enterprise to
SP.

On the opposite direction, Routing profile EN-RP was created to be used in conjunction with Server
Flow (see Section 6.5.4) defined for SP. This entry is to route incoming calls from SP to the EN.
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6.3.4.1 Routing Profile for SP

The screenshot below illustrates the routing profile from Avaya SBCE to the SP network, Global
Profiles = Routing: SP-RP. As shown in Figure 1, the SP SIP trunk is connected with
transportation protocol UDP. If there is a match in the “To” or “Request URI” headers with the URI
Group “** defined in Section Error! Reference source not found., the call will be routed to the Next
Hop Address which is the IP address of SP SIP trunk.

Session Border Controller for Enterprise AVAYA

Dashboard Routing Profiles: SP-RP

Administration
Add Rename Clone Delete
Backup/Restore

System Management Routing Profiles Click here to add a description.

default
> Global Parameters Routing Profile
4 Global Profiles To_IPO_MTS
D in DoS Update Priority Add
omain Dol e
Server Interworkin
g To RC Priority gRl Time of Day  Load Balancing Next Hop Address Transport
Media Forking o roup
Routing To_ThinkTel . default Priarity 192.168.61.201 uDP Edit Delete
Server Configuration To IPO

Topology Hiding o

Signaling Manipulation

6.3.4.2 Routing Profile for EN

The Routing Profile for SP to EN, SP-to-EN, was defined to route calls where the “To” header
matches the URI Group “*” defined in Section Error! Reference source not found. to Next Hop
Address which is the IP address of IP Office WAN port as a destination. As shown in Figure 1, the
SIP trunk between EN and the Avaya SBCE is connected with transportation protocol TLS.

Session Border Controller for Enterprise AVAYA

Dashboard Routing Profiles: EN-RP

Administration

Add Rename Clone Delete
Backup/Restore
Routing Profiles Click here to escription.
System Management LA e d Click here to add a description
> Global Paramet EN-RP i -
obal Parameters Routing Profile
4 (Global Profiles To_IPO
. Update Priority Add
Domain DoS SPRP
i — URI Time of Load Next Hop AnsDo
Server Interworking Priority Group Day Balancing Address Lzispe
Media Forking
Routing . default  Priority 10.10.97.61 TLS  Edit Delete
QT; Reviewed: Solution & Interoperability Test Lab Application Notes 41 of 59

SPOC 3/27/2018 ©2018 Avaya Inc. All Rights Reserved. GIPO10101SBC721



6.3.5. Topology Hiding

Topology Hiding is a security feature of the Avaya SBCE which allows changing certain key SIP
message parameters to ‘hide’ or ‘mask’ how the enterprise network may appear to an unauthorized
or malicious user.

To create a Topology Hiding profile, select Global Profiles > Topology Hiding then click on the
Add Profile (not shown).

In the compliance testing, two Topology Hiding profiles were created: SP-TH and EN-TH.

6.3.5.1 Topology Hiding Profile for SP

Topology Hiding profile SP-TH was defined for outgoing calls to SP to:
e Mask URI-Host of the “Request-Line” and “To” headers with service provider SIP domain to
meet the requirements of SP.
e Mask URI-Host of the “From” header to SP SIP domain as shown in capture below.

This implementation is to secure the enterprise network topology and also to meet the SIP
requirements from the service provider.

The screenshots below illustrate the Topology Hiding profile SP-TH.

Session Border Controller for Enterprise AVAYA

Dashboard Topology Hiding Profiles: SP-TH

Administration
Add Rename Clone Delete
Backup/Restore

Systemn Management E:(I:%l:gy Hiding Click here to add a description.

» Global Parameters o
i default Topology Hiding
4 Global Profiles
Domain DoS cisco_th_profile Header Criteria Replace Action Owverwrite Value
Server Interworking To_IPO From IP/Domain Ovenwrite 192.168.61.201
Media Forking EN-TH Record-Route IP/Domain Auto —
Routing To RC Refer-To IP/Domain Auto
Server Configuration - }
Topology Hiding To_ThinkTel SDP IP/Domain Auto —
Signaling Manipulation To PO 42 Referred-By IP/Domain Auto
URI Groups To_IPO_210 Via IP/Domain Auto —
SHMP Traps Request Line IP/Domain Overwrite 192.168.61.201
Time of Day Rules TPl ; ]
To IP/Domain Overwrite 192.168.61.201
FGDN Groups SP-TH
Reverse Proxy Policy To_IPO_48 Edit
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6.3.5.2 Topology Hiding Profile for EN

Topology Hiding profile EN-TH was defined for incoming calls to IP Office to:

e Mask URI-Host of the “Request-Line”, “To”, and “From” headers with the enterprise SIP

domain.

e |eave the “Record-Route”, “Via” headers and SDP to default Auto.

The screenshots below illustrate the Topology Hiding profile EN-TH.

Dashboard

Administration

Backup/Restare

System Management

> Global Parameters

4 Global Profiles
Domain DoS
Server Interworking
Media Forking
Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups
SNMP Traps
Time of Day Rules
FGDN Groups

> PPM Services

Topology Hiding Profiles: EN-TH

Topology Hiding

Profiles

default

EN-TH

SP-TH

Add

Header
Record-Route
To

SDP
Referred-By
Via

From
Refer-To

Request-Line

Topology Hiding

Session Border Controller for Enterprise

Click here to add a description.

AVAYA

Rename Clone Delete

Criteria

IP/Domain
|IP/Domain
IP/Domain
IP/Domain
IP/Domain
IP/Domain
IP/Domain

IP/Domain

Replace Action

Auto
Overwrite
Auto
Auto
Auto
Cwverwrite
Auto

QOverwrite

Edit

Overwrite Value

avayalab.com

avayalab.com

avayalab.com
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6.4. Domain Policies

The Domain Policies feature configures various rule sets (policies) to control unified
communications based upon criteria of communication sessions originating from or terminating at
the enterprise. These criteria can be used to trigger policies which, in turn, activate various security
features of the Avaya SBCE security device to aggregate, monitor, control and normalize call flow.
There are default policies available for use, or a custom domain policy can be created.

6.4.1. Signaling Rules

Signaling Rules define the action to be taken (Allow, Block, Block with Response, etc.) for each
type of SIP-specific signaling request and response message. When SIP signaling packets are
received by the Avaya SBCE, they are parsed and “pattern-matched” against the particular signaling
criteria defined by these rules. Packets matching the criteria defined by the Signaling Rules are
tagged for further policy matching.

To clone a signaling rule, navigate to Domain Policies = Signaling Rules, select the default rule
then click on the Clone Rule button (not shown).

In the compliance testing, two Signaling Rules were created for SP and EN.

6.4.1.1 Signaling Rule for SP
Clone the Signaling Rule default with a descriptive name e.g., SP-SR and click on the Finish button
(not shown). Verify that General settings of SP-SR with Inbound and Outbound Request were set

to Allow, and Enable Content-Type Checks was enabled with Action and Multipart-Action were
set to Allow (not shown).

On the Signaling QoS tab, enter the following information.
e Select the proper Quality of Service (QoS).
e The Avaya SBCE can be configured to mark the Differentiated Services Code Point (DSCP)
in the IP packet header with specific values to support Quality of Services policies for
signaling.

The following screen shows the QoS value used for the compliance testing.

Session Border Controller for Enterprise AVAYA
Dashboard Signaling Rules: SP-SR
pAdministration | Add | Filter By Device... - I Rename H Clone H Delete I
Backup/Restore —
Systemn Management Click here to add a description.
» Global Parameters SP-SR me]ﬂ | Requests | | Responses | | Request Headers | | Response Headers | | Signaling QoS |
[« Domain Palicies ucip

Application Rules Signaling QoS

Border Rules

Media Rules QoS Type Dsce

Security Rules DscP EF

Slgnall.ng Ru.les IHI
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6.4.1.2 Signaling Rule for EN

Clone the Signaling Rule default with a descriptive name e.g. EN-SR for EN and click on the
Finish button (not shown). Verify that General settings of EN-SR with Inbound and Outbound
Request were set to Allow, and Enable Content-Type Checks was enabled with Action and
Multipart-Action were set to Allow (not shown). Similarly the Signaling QoS rules are set as
shown in capture below.

Session Border Controller for Enterprise AVAYA

Dashboard Signaling Rules: EN-SR

Aidministration

Add Filter By Device... - [ Rename ” Clone ][ Delete ]

Packup/Restore — ; -
Systemn Management Signaling Rules Click here to add a description.
* Global Parameters EN-SR meTﬂ| Request || Resp || Request Headers || Resp Head || Signaling Qo5 |
k¥ Domain Policies Sp.SR ucio

Application Rules Signaling QoS

Border Rules

Media Rules QoS Type DSCP

Security Rules DsCP EF

Signaling Rul

oo
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6.4.2. Application Rules

Application Rules define which types of SIP based Unified Communications (UC) applications the
Avaya SBCE security device will protect: voice, video, and/or Instant Messaging (IM). In addition,
user can determine the maximum number of concurrent voice and video sessions the network will
process in order to prevent resource exhaustion.

6.4.2.1 Application Rule for SP

Clone the Application Rule default with a descriptive name e.g., SP-AR for service provider and
click the Edit button to change value of Maximum Concurrent Sessions and Maximum Session
Per Endpoint to 500 respectively as shown and then click the Finish button (not shown). Others are
left as default.

Session Border Controller for Enterprise AVAYA

Dashboard Application Rules: SP-AR

Aidministration

Add Filter By Device... - Rename ][ Clone ” Delete ]
Packup/Restore
Applicati Click here to escription.
Systern Management PEE.ICE ion lick here to add a description
" Global Parameters Foiw Application Rule
" Global Profiles
. _ . Maximum Concurrent  Maximum Sessions
- PPM Services RW-AR Application Type Sessions ' Per Endpoint o
¥ Domain Policies EN-AR
o Audio 500 500
Application Rules
Border Rules Video o O

6.4.2.2 Application Rule for EN

Similarly, clone the Application Rule default with a descriptive name e.g., EN-AR for IP Office and
click the Edit button to change value of Maximum Concurrent Sessions and Maximum Session
Per Endpoint to 500 respectively as shown and then click the Finish button (not shown). Others are
left as default.

Session Border Controller for Enterprise AVAYA
Dashboard Application Rules: EN-AR
Administration Add Filter By Device... v Rename | [ clone | [ Delete |
Backup/Restore — ) m
Systern Management gﬁgfatmn Click here to add a description.
> Global Parameters I Application Rule
> Global Profiles : " ) )
. PPM Services RW-AR Application Type In Out gqfxu:};m Concurrent 'I!?frxg:gglifswona
., . .
Domain Policies EN-AR Audio 500 500
Application Rules
Border Rules Yz 0 0
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6.4.3. Media Rules

Media rules can be used to define RTP media packet parameters, such as prioritizing encryption
techniques and packet encryption techniques. Together these media-related parameters define a strict
profile that is associated with other SIP-specific policies. You can also define how Avaya SBCE
must handle media packets that adhere to the set parameters.

6.4.3.1 Media Rule for SP

In this compliance testing, Secure Real-Time Transport Protocol (SRTP, media encryption) is not
supported by SP. Therefore, default-low-med rule is used for communication between Avaya SBCE
and SP.

6.4.3.2 Media Rule for EN

Secure Real-Time Transport Protocol (SRTP, media encryption) is used between Avaya SBCE and
IP Office. Therefore, it is necessary to create a media rule to apply to the internal interface of Avaya
SBCE, EN. Created EN-SRTP-MR rule is shown below.

Session Border Controller for Enterprise AVAYA

Dashboard Media Rules: EN-SRTP-MR

Administration

Add | Filter By Device... v| Rename Clone Delete

Backup/Restore
Media Rules Click here to add a description.
System Management
> Global Parameters default-low-med Encryption || Codec Prioritization || Advanced || QoS |
oS e |
. Audio Encryption
> PPM Services default-hiah : bl
+ Dormain Policies 9 SRTP_AES_CM_128_HMAC_SHA1 32
default-high-enc Preferred Formats SRTP_AES _CM_128_HMAC_SHA1_80
Application Rules g RTP
Border Rules avaya-low-me... Encrypted RTCP
Media Rules MTSAllstrea... VK O
Security Rules —
Signaling Rules = Lifetime By
End Point Policy ThinkTel_MR Interworking
Groups IPO_MR
Session Policies SPMR Video Encryption
» TLS Management Preferred Formats RTP
> Device Specific Settings SRS
Interworking |
RTP-RW
SP-SRTP-MR Miscellaneous
EN-SRTP-MR Capability Negatiation O
SP4_IPO_42

Edit

6.4.4. Endpoint Policy Groups

The rules created within the Domain Policy section are assigned to an Endpoint Policy Group.
The Endpoint Policy Group is then applied to Server Flow defined in Section 6.5.4.
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Endpoint Policy Groups were separately created for SP and EN.

To create a policy group, navigate to Domain Policies = Endpoint Policy Groups and click on the
Add button.

6.4.4.1 Endpoint Policy Group for SP

The following screen shows SP-PG created for SP.

Set Application Rules to SP-AR which was created in Section 6.4.2.1.
Set Media Rules to default-low-med.

Set Signaling Rules to SP-SR which was created in Section 6.4.1.1.
Set Border Rules to default.

Set Security Rules to default-med.

Session Border Controller for Enterprise AVAYA

4 Domain Policies Policy Groups: SP-PG
Application Rules

Add |Fi|ter By Device... ~ Rename Clone Delete

Border Rules

Paolicy Groups Click here to add a description.

Media Rules
Security Rules default-low Hover over a row to see its description.
Signaling Rules default-low-enc -
End Point Policy sefatitmed Policy Group
Groups Summary
Session Policies default-med-enc - — , : —
Order Application Border Media Security Signaling
> TLS Management EN-PG
> Device Specific Settings SP.PG SP-AR default Iclo.?ﬁ#!ta_d default-med SP-SR Edit

6.4.4.2 Endpoint Policy Group for EN
Similarly, the following screen shows policy group EN-PG created for EN.

Session Border Controller for Enterprise AVAYA

4 Domain Policies Policy Groups: EN-PG
Application Rules

Add |Fi|ter By Device... ~ Rename Clone Delete

Border Rules

Media Rules Policy Groups Click here to add a description.
- default-low ) o
Security Rules Hover over a row to see its description.
Signaling Rules default-low-enc
End Point Policy st Policy Group
Groups Summary
Session Policies default-med-enc - — . . —
Order Application Border Media Security Signaling
> TLS Management EN-PG
. Device Specific Settings s EN-AR default EN-SRTP-MR  default-med  EN-SR Edit

6.5. Device Specific Settings

The Device Specific Settings feature allows aggregate system information to be viewed and various
device-specific parameters to be managed to determine how a particular device will function when
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deployed in the network. Specifically, it gives the ability to define and administer various device-
specific protection features such as Message Sequence Analysis (MSA) functionality and protocol
scrubber rules, end-point and session call flows, as well as the ability to manage system logs and
control security features.

6.5.1. Network Management

The Network Management page is where the network interface settings are configured and enabled.
During the installation process of the Avaya SBCE, certain network-specific information is defined
such as device IP address, public IP address, subnet mask, gateway, etc., to interface the device to
the networks. This information populates the various Network Management tabs which can be edited
as needed to optimize device performance and network efficiency.

Navigate to Device Specific Settings = Network Management, under Interfaces tab, enable the
interfaces connecting to the inside enterprise and outside service provider networks. To enable an
interface, click on “Disable” Status. The following screen shows interface Al and B1 were Enabled.

Session Border Controller for Enterprise AVAYA

Dashboard Network Management: mSBCE
Administration

> TLS Management
] - : Devices Interfaces | | Networks |
4 Device Specific Settings

Network mSBCE
Management
Interface Name VLAN Tag Status
Media Interface: A E—
napled
Signaling Interface
End Point Flows B Enabled

On the Networks tab, verify the IP addresses assigned to the interfaces and that the interfaces were
enabled. The following screen shows the private interface was assigned to Al and the public
interface was assigned to B1 appropriate to the parameters shown in the Figure 1.

Session Border Controller for Enterprise AVAYA

Dashboard Network Management: mSBCE
* Global Parameters
> Global Profiles

. PPM Services Interfaces Network5|

m3BCE

Add

» Domain Policies

* TLS Management Gateway Subnet Mask Interface IP Address
14 Device Specific Settings
MNetwork_A1 10.10.97.129 255255266192 A1 10.10.97.176  Edit Delete
MNetwork
Management
Media Interface MNetwork_B1 10.10.98.97 255255266224 B1 10.10.98.103  Edit Delete

Signaling Interface

6.5.2. Media Interface

The Media Interface screen is where the media ports are defined. The Avaya SBCE will open
connection for RTP traffic on the defined ports.
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To create a new Media Interface, navigate to Device Specific Settings = Media Interface and
click on the Add Media Interface button (not shown).

Two separate Media Interfaces are needed for the inside and outside interfaces. The following screen
shows the Media Interfaces InsideMedia and OutsideMedia were created for the compliance
testing.

Note: After the media interfaces are created, an application restart is necessary before the changes
will take effect.

Session Border Controller for Enterprise AVAYA
Dashboard Media Interface: mSBCE
Administration
Backup/Restore
System Management Media Interface
> Global Parameters mSBCE
. Global Profi Modifying or deleting an existing media interface will require an application restart before taking effect.
obal Frotiies Application restarts can be issued from System Management.
> PPM Services
> Domain Policies (il
> TLS Management Name N:ﬂlﬁ P Port Range TLS Profile
4 Device Specific Settings
InMedia 10.10.57.176 35000 - 40000 None Edit Delete
Network Management SR (R O]
Media Interface OutMedia 10.10.98.103 35000 - 40000 None Edit Delete

Network_BA1 (B1, VLAN 0)

Signaling Interface
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6.5.3. Signaling Interface

The Signaling Interface screen is where the SIP signaling port is defined. The Avaya SBCE will

listen for SIP requests on the defined port.

To create a new Signaling Interface, navigate to Device Specific Settings - Signaling Interface

and click on the Add button.

Two separate Signaling Interfaces are needed for both inside and outside interfaces. The following
screen shows the Signaling Interfaces InsideSIG and OutsideSIG that were created for the
compliance testing with TLS/5061 and UDP/5060 respectively configured for the inside and outside

interfaces.
Session Border Controller for Enterprise AVAYA
Dashboard Signaling Interface: mSBCE
Administration
Backup/Restore
System Management Signaling Interface
> Global Parameters mSBCE
Global Profil Modifying or deleting an existing signaling interface will require an application restart before
» olobal Fronies taking effect. Application restarts can be issued from System Management.
> PPM Services
> Domain Policies S
> TLS Management Name Signaling IP TCP UDP TS apfle
- Pot Pot Port
4 Device Specific Settings Lo ° ° °
Network Management InsideSIG 1&&%1{15 — — 5061 EM-SP Edit Delete
VLAN O
Media Interface ;
Signaling Interface OutsideSIG 1&]&?311{2? — 5060 — Mone Edit Delete
End Point Flows LA
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6.5.4. End Point Flows - Server Flow

When a packet is received by the Avaya SBCE, the content of the packet (IP addresses, URISs, etc.) is
used to determine which flow it matches. Once the flow is determined, the flow points to a policy
which contains several rules concerning processing, privileges, authentication, routing, etc. Once
routing is applied and the destination endpoint is determined, the policies for this destination
endpoint are applied. The context is maintained, so as to be applied to future packets in the same
flow. The following screen illustrates the flow through the Avaya SBCE to secure a SIP Trunk call.

“Call Server” — Trunk Server “Trurk
Call Sen Mcly 5 P
D e D Policy Group N Flow D Gfrpr olicy D
F
. ow =

“Call Server” *Trunk"Policy Trunk Server
<] Palicy Group <:| Sl Group <] Flow <]

In the compliance testing, two separate Server Flows were created for SP and EN.

a
1P-POX

SP Trunk Service Provider
o

To create a Server Flow, navigate to Device Specific Settings = End Point Flows, select the
Server Flows tab and click on the Add Flow button (not shown). In the new window that appears,
enter the following values while the other fields were kept as default.
e Flow Name: Enter a descriptive name.
e Server Configuration: Select the Server Configuration created in Section 6.3.3 associated
with Server Flow.
e URI Group: Select “*”.
e Received Interface: Select the Signaling Interface created in Section 6.5.3 from which the
Server Configuration is designed to receive SIP signaling.
e Signaling Interface: Select the Signaling Interface created in Section 6.5.3 to which the
Server Configuration is designed to send SIP signaling.
e Media Interface: Select the Media Interface created in Section 6.5.2 to which the Server
Configuration is designed to send the RTP media.
e End Point Policy Group: Select the End Point Policy Group created in Section 6.4.4.
e Routing Profile: Select the Routing Profile created in Section 6.3.4.
e Topology Hiding Profile: Select the Topology Hiding profile created in Section 6.3.5 to
apply toward the Server Configuration.
e Use default values for all remaining fields. Click Finish to save and exit.

QT; Reviewed: Solution & Interoperability Test Lab Application Notes 52 of 59
SPOC 3/27/2018 ©2018 Avaya Inc. All Rights Reserved. GIP010101SBC721



The following screen shows the Server Flow SP-SF for SP.

Flow Mame

Server Configuration
URI Group
Transport

Remote Subnet
Received Interface
Signaling Interface

Media Interface

Edit Flow: S5P-5F

i *
<
< <

*

InsideSIG

OutsideSIG W

OutMedia

Secondary Media Interface None

End Point Policy Group | SP-PG

Routing Profile EN-RP
Topology Hiding Profile SP-TH

Signaling Manipulation Script None

I( I
{
<

Remote Branch Office Any

Finish
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Similarly, the following screen shows the Server Flow EN-SF for IP Office.

Edit Flow: EN-SF

Flow Name

Server Configuration
URI Group

Transport

Remote Subnet =

Received Interface OutsideSIG ~
Signaling Interface InsideSIG
Media Interface InMedia

Secondary Media Interface Hone

End Point Policy Group | EN-PG

Routing Profile SP-RP
Topology Hiding Profile EN-TH
Signaling Manipulation Script None

Remaote Branch Office Any ~

Finish
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7. Gamma SIP Trunking Configuration

Gamma is responsible for the configuration of the Gamma SIP Trunking service. The customer will
need to provide the IP address used to reach the Avaya IP Office at the enterprise, this address will
be the outside interface of the Avaya SBCE. Gamma will provide the customer the necessary
information to configure the Avaya IP Office SIP connection to Gamma. The provided information
from Gamma includes:

IP address of the Gamma SIP proxy.

Supported codecs.

DID numbers.

IP addresses and port numbers used for signaling or media through any security devices.

8. Verification Steps
The following steps may be used to verify the configuration:

e Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start = Programs - IP Office = System Status on the PC
where Avaya IP Office Manager was installed. Select the SIP line of interest from the left
pane. On the Status tab in the right pane, verify that the Current State is Idle for each
channel (assuming no active calls at present time).
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IP Office System Status

Status  Utiization Summary Alarms  Registration

SIP Trunk Summary

Line Service State: In Service

Peer Domain Mame: avayalab.com

Resolved Address: 10.10,97.176

Line Mumber: 19

Number of Administered Channels: 11

Mumber of Channels in Use: a

Adminiztered Compression: G711A G729 A

Enable Faststart: off

Silence Suppression: Off

Media Stream: Best Effort

Layer 4 Pratocol: TLS

SIP Trunk Channel Licenses: 128 . i
SIP Trunk Channel Licenses in Use: i}

SIF Device Features: UPDATE {Incoming and Cutgoing)

rent Timein Remote Co... Conn... Calle Direct... Round Receive ve Trans... Trans...

1 Ide |00:12... ~
2 Ide |00:12...
3 Ide ([11:32...
4 Idle |[11:32...
5 Idle |[11:32...
] Ide [11:32... A
—
Trace Trace Al Pause Fing Call Details Graceful Shutdown Force Cut of Service Print...
Save As...

11:19:57 PM Online &

e Select the Alarms tab and verify that no alarms are active on the SIP line.

IP Office System Status

Alarms

Status  Utilization Summary

Alarms for Line: 19 SIP avayalab.com

Last Date Of Error Occurrences Error Description

Clear Clear all Graceful Shutdown ] [ Force Qut of Service Print... Save As...

Online

12:47:59 PM

e Verify that a phone connected to PSTN can successfully place a call to the Avaya IP Office
with two-way audio.

e Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.
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e Using a network sniffing tool e.g., Wireshark to monitor the SIP signaling between the
enterprise and Gamma. The sniffer traces are captured at the public interface of the Avaya
SBCE.

9. Conclusion

The Gamma SIP Trunking passed compliance testing. These Application Notes describe the
procedures required to configure the SIP connection between Avaya IP Office, Avaya SBCE and the
Gamma SIP Trunking service as shown in Figure 1.
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Product documentation for Avaya products may be found at http://support.avaya.com. Additional IP
Office documentation can be found at;
http://marketingtools.avaya.com/knowledgebase/

Product documentation for Gamma SIP Trunking is available from Gamma.

QT; Reviewed: Solution & Interoperability Test Lab Application Notes 58 of 59
SPOC 3/27/2018 ©2018 Avaya Inc. All Rights Reserved. GIP010101SBC721


http://support.avaya.com/
http://marketingtools.avaya.com/knowledgebase/

©2018 Avaya Inc. All Rights Reserved.

Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and ™
are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the
property of their respective owners. The information provided in these Application Notes is
subject to change without notice. The configurations, technical data, and recommendations
provided in these Application Notes are believed to be accurate and dependable, but are
presented without express or implied warranty. Users are responsible for their application of any
products specified in these Application Notes.
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